
THE
PURRFECT
TRAININGS
Custom trainings for high 
performance teams.

ALL



Our courses combine knowledge from our previous and 
ongoing consulting projects to deliver practical, hands-
on experiences. 

Based in Austria, we provide European-wide training and workshops 
available in German and English. Due to our positive experiences 
and the flexibility it offers, we mostly give our courses remotely. If 
requested, we are also available on-site. 
Infralovers is an official HashiCorp partner since January 2022.  

Our Experienced trainers have built up years of experience in 
our consulting projects. We only teach what we have personally 
experienced, tested, and applied with clients. This is the only way we 
can credibly and professionally teach our knowledge to our training 
participants.

DI Edmund Haselwanter
CEO & Chef Trainer

Our experienced 
trainers have years of 
field experience and 
evolve constantly.

Infralovers is an 
Austrian based 
company in Graz.

Our most loved trainings 
are about HashiCorp,
Cloud Native, GitLab, 
Kubernetes & Ansible.

ABOUT
INFRALOVERS

LANGUAGE &
LOCATION

EXPERIENCED
TRAINERS

CLOUD
FOCUS

EU 
BASED

AVERAGE HOURS 
OF COURSES GIVEN 
PER YEAR

OF ATTENDEES WOULD 
LOVE TO ATTEND  
FURTHER COURSES.

10+ YEARS OF  
EXPERIENCE 
AND KNOWLEDGE. 

FACT-
SHEET

1.560 94 % 2013

GET YOUR PERSONALISED QUOTE: TEAM@INFRALOVERS.COM

All our courses can be held 
in English or German. We 
mostly teach remotely but 
are also available on-site.



OUR 
COURSES

CONTENT

There are tons of great 
tasting courses here, one 

better than the other.

We are IT-Experts and we 
want you to be one too. All 
our trainers have years 
of experience in the tech 
industry and are experts at 
teaching complex topics in a 
simple way. 

KING
OF CLOUD
TRAININGS

HASHICORP	
Terraform Foundations	
Advanced HCP Terraform/Enterprise		
Terraform Plugin Development	  
Terraform Testing	

Vault Enterprise
Consul Enterprise	
Nomad Essentials	

CLOUD NATIVE 	
Cloud Native Bootcamp	
Cloud Native Essentials	
Observability	  
GitOps
GitLab Essentials	

INFRASTRUCTURE AS CODE 	
Ansible Essentials 
Ansible AWX	
Chef Essentials	

Terraform Foundations	
Advanced HCP Terraform/Enterprise		
Terraform Plugin Development	  
Terraform Testing

DEVOPS, CI/CD	
GitOps	
GitLab Essentials	
Agile Testing Essentials	
Agile Testing & CI/CD	
Terraform Testing
AI/LLM Essentials for DevOps	

SECURITY
Mondoo Essentials
Mondoo Advanced	
EU NIS2 Guidelines
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HASHICORP
SOLUTIONS

HASHICORP CLOUD OPERATING MODEL*

ABOUT HASHICORP

TOOLS

HashiCorp products automate, 
secure and simplify infrastructure 
management, boosting operational 

efficiency in modern IT.

HashiCorp offers a range of 
solutions that simplify the 
process of managing and 
securing your infrastructure, 
including tools for 
provisioning, configuring, 
securing, and operating cloud 
infrastructure.

KING
OF CLOUD
TRAININGS

HashiCorp products provide powerful 
automation and collaboration tools that 
simplify the management of modern 
infrastructure, ensuring scalability, security, 
and agility for organizations.

Terraform enables you to easily create, manage, and 
update infrastructure as code across multiple cloud 
providers and on-premises, reducing human error and 
increasing efficiency.

Consul is a centralized platform for service discovery, 
configuration, and segmentation, allowing you to 
easily connect and secure distributed applications and 
services.

Vault provides secure storage and management of 
secrets and sensitive data, as well as access control and 
auditing capabilities, helping you to protect critical 
assets and meet compliance requirements.

Nomad is a powerful and easy-to-use platform for 
deploying and managing containerized and non-
containerized applications across diverse infrastructure, 
enabling you to achieve greater flexibility, scalability, 
and resilience in your IT operations.

The fastest path to unlock value in a multi-cloud datacenter, 
enabling efficient collaboration of people, processes, and 
tools. 
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*developer.hashicorp.com/well-architected-framework



HASHICORP
CLOUD 
OPERATING
MODEL*

INFRALOVERS EDITION

HASCHICORP ACADEMY 
& OUR HASHICORP COURSES

LET’S LIFT 
OFF TO THE
CLOUDS.

HashiCorp's cloud operating model 
enables your organization to unlock the 
fastest path to value in a modern  
multi-cloud datacenter. When your  
organization adopts this common  
operating model, it enables people,  
processes, and tools to work most efficiently.

We help you to start your state of the 
art multi-cloud datacenter today with 
our wide variety of HashiCorp courses.

INFRASTRUCTURE
AUTOMATION
WITH TERRAFORM

SECURITY AUTOMATION
WITH VAULT

> Identity-based security
> Secrets management
> Encryption as a service
> Advanced data protection

> Workload orchestration
> Container orchestration
> Heterogeneous orchestration

> Infrastructure as code
> Compliance & management
> Self service infrastructure

1. PROVISION

2. SECURE

4. DEPLOY
APPLICATION AUTOMATION
WITH NOMAD

Terraform Foundations  
Advanced HCP Terraform/Enterprise    
Terraform Plugin Entwicklung 
Terraform Testing
Vault Enterprise   
Consul Enterprise   
Nomad Essentials

NETWORKING AUTOMATION
WITH CONSUL
> Common service registry
> Health monitoring
> Networking middleware automation
> Service mesh

3. NETWORK

*developer.hashicorp.com/well-architected-framework

OFFICIAL
TRAININGS

PARTNER



TERRAFORM 
FOUNDATIONS

Introduction to modern 
infrastructure provisioning.

DESCRIPTION 

This is an introductory course that covers HashiCorp 
Terraform, a simple and powerful tool for safely 
and predictably creating, changing, and improving 
infrastructure. If you have never used Terraform, this 
is the place to start.

Students will receive access to their own personal 
Linux-based lab environment for the class. This is a 
three day course and it includes time for lectures, lab 
exercises, Q&A, and several breaks.

AGENDA 

> Terraform Introduction
> Terraform Internals and Usage
> Terraform CLI
> Language
>  State
>  Providers
>  Cloud Authentication
>  Modules
>  Versioning
>  Language Intermediate
>  Templates
>  Provisioners
>  Module Development
>  Terraform Testing
>  Recommended Patterns

Terraform is the most popular 
„Infrastructure as Code“ tool 

on the market. A de facto  
standard since many years.

The WiseWhale fact

AUDIENCE

Anyone who wants to learn Terraform.

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

3 Days BeginnerTopic: HashiCorp

HASHICORP ACADEMY

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/hashicorp-terraform-foundations/


ADVANCED  
HCP TERRAFORM/
ENTERPRISE

DESCRIPTION 

This course is aimed at existing Terraform users who 
desire an in-depth exploration of collaborative work-
flows and advanced features with Terraform Cloud or 
Enterprise. 

Students will receive access to their own personal 
Linux-based lab environment for the class. We highly 
recommend to complete the “Terraform Foundations” 
course before attending this one.

AGENDA 

>	Terraform Review
>	TFC/E Platform and UI
>	State (remote and importing resources)
>	Workspaces
> TFC/E Variables
>	Workflows - CLI, VSC, API
> User & Group Organization
> Private Module Registry
> Operations and Governance
>	Policy as Code (Sentinel)

Let‘s provide a secure, scalable, 
and collaborative infrastructure 

management.

The CleverRacoon says:

AUDIENCE

> Cloud SRE‘s
> DevOps
> System Administrators

PREREQUISITES

>	Terraform Foundations
> GitLab Essentials
>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

3 Days IntermediateTopic: HashiCorp

Collaborative infrastructure automation.

HASHICORP ACADEMY

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/hashicorp-advanced-terraform-cloud-enterprise/


TERRAFORM  
PLUGIN  
DEVELOPMENT
Write your own Terraform plugins 
with ease.

DESCRIPTION 

Terraform supports a plugin model, and all providers 
are actually plugins. Plugins are distributed as Go 
binaries. With such a plugin system, it is easy to extend 
Terraform with custom features.

This course will show how to write your own Terraform 
plugins. We will go into the challenges that come with it 
and provide lots of best-practices to get you started.

AGENDA 

>	What are Terraform plugin?
>	Terraform provider/plugin skeleton
>	The provider schema
>	Building a plugin
>	Defining resources
>	Invoking your custom provider
>	Error Handling & Partial State
>	Plugin best-practices

„Terraform is developed with 
Go. You should definitely have 

a look at this programming 
language before this training. 

Otherwise you will go ape!„

The GoGorilla says:

AUDIENCE

Regular Terraform users.

PREREQUISITES

>	Terraform Foundations
> Basic understanding of Go
>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

2 Days IntermediateTopic: HashiCorp

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/terraform-plugin-development/


TERRAFORM  
TESTING 
Test your Terraform managed 
infrastructure.

DESCRIPTION 

After working with Terraform for some time, the 
following question often arises: How do you test 
the developed code as automatically as possible? A 
terraform run shows us the result, but can we really 
trust it? Terraform test tools help us with the answer.

This course shows how to use the most common test 
tools for Terraform to test your own modules and their 
results. In addition, the course teaches as much Go as 
you need to use these tools.

AGENDA 

>	What are infrastructure tests?
>	Why and how to test Terraform?
>	Linting Terraform
>	Go basics
>	Terratest
>	Kitchen-Terraform
>	Terraform Test
>	Best-practices when testing Terraform

Better safe than sorry. Those who 
do not test prior to deploying to 
production will soon find them-
selves overwhelmed with issues 

and challenges.

The SmartDog tip

AUDIENCE

System and cloud administrators who 
are interested in using infrastructure 
tests for Terraform and automating 
them.

PREREQUISITES

>	Terraform Foundations
>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

2 Days IntermediateTopic: HashiCorp

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/terraform-testing/


VAULT  
ENTERPRISE

Introduction to HashiCorp Vault. 

DESCRIPTION 

This is an introductory course that covers HashiCorp 
Vault, a simple and powerful tool for managing secrets 
& protecting sensitive data. If you have never used 
Vault, this is the place to start.

Students will receive access to their own personal 
Linux-based lab environment for the class. This is a 
three day course and it includes time for lectures, lab 
exercises, Q&A, and several breaks.

AGENDA 

> Vault Architecture
> Vault Configuration
> Static Secrets
> Deploying Secrets
> Tokens
> Policies
> Authentication Methods
> Dynamic Secrets
> Vault Deployment Guidelines
> Vault Operations
> Incident Management
> Enterprise Replication 

“An investment in knowledge 
pays the best interest.“ -  

Benjamin Franklin

The CraftyDonkey quote

AUDIENCE

Anyone who wants to learn Vault.

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

3 Days BeginnerTopic: HashiCorp

HASHICORP ACADEMY

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/hashicorp-vault-enterprise/


CONSUL  
ENTERPRISE

Connect dynamic applications.

DESCRIPTION 

This is an introductory course that covers HashiCorp 
Consul. Consul is a powerful tool that can automate 
network configurations, discover services, and enable 
secure connectivity across any cloud or runtime.

Students will receive access to their own personal 
Linux-based lab environment for the class. This is a 
three day course and it includes time for lectures, lab 
exercises, Q&A, and several breaks.

AGENDA 

> Introduction to Consul
> Consul architecture
> Installation
> Secure deployment
> Service Discovery
> Service Mesh
> Configuration Entries
> Gateways
> Integrations
> Consul Operations and Maintenance

“Less is more”, that may apply 
to some areas of life. When it 
comes to knowledge, this is 
clearly the wrong approach.

The SmartCat tip

AUDIENCE

Anyone who wants to learn Consul.

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

3 Days BeginnerTopic: HashiCorp

OFFICIAL
TRAININGS

PARTNER

HASHICORP ACADEMY

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/hashicorp-consul-enterprise/


NOMAD 
ESSENTIALS
Deploy and manage containers 
and non-containerized 
applications.

DESCRIPTION 

This is an introductory course aimed at users who 
desire an in-depth exploration of Nomad including 
architecture, installation & configuration, scheduling, 
operations, and advanced topics.

Students will receive access to their own personal 
Linux-based lab environment for the class.

AGENDA 

> Architecture Overview
> Installing and Configuring Nomad
> Creating and Running Jobs
> Service Discovery with Consul
> Operating Nomad
> Interacting with the HTTP API
> Advanced Job Strategies

„Knowing is not enough - you 
have to apply. It is not enough 
to want - you have to do it too.“ 

- Goethe

The CraftyDonkey quote

AUDIENCE

Anyone interested in Nomad.

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

1 Day BeginnerTopic: HashiCorp

KING
OF CLOUD
TRAININGS

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/hashicorp-nomad-101/


YOUR WAY 
TROUGH
CLOUD NATIVE*

OUR CLOUD NATIVE COURSES

*www.cncf.io

4. OBSERVABILITY & ANALYSIS

1. CONTAINERISATION

SEE FROM PAGE 16

SEE FROM PAGE 23

PAGE 16

PAGE 17

All applications and dependencies can 
be containerized. It is recommended 

to aim for breaking down appropriate 
applications and developing new fea-

tures as micro services over time. 

Kubernetes is the market 
leader solution for 
orchestration solution.

Implement a CI/CD pipeline that automates build-
ing, testing, and deploying new container images 

whenever changes are made to the source code. 
Automatic testing, rollouts, and rollbacks ensure 

smooth and reliable deployment to staging and 
production environments.

Solutions for monitoring,  
logging and trace like  

Fluentd, Jaeger, Prometheus

2. CI/CD

3. ORCHESTRATION

LET’S WALK
THE PATH
TOGETHER.



OUR
CLOUD
NATIVE
COURSES

TRAININGS 

ABOUT CLOUD NATIVE

TOOLS

Cloud native improves 
performance and saves 
money by using smarter 

technology.

Cloud native allows faster 
development, easier 
scalability, higher resilience, 
and lower costs through the 
use of containerization and 
micro services.

KING
OF CLOUD
TRAININGS

Cloud Native Bootcamp	
GitOps	
Cloud Native Essentials	
Observability	

Cloud Native is a method for creating and running 
applications that utilize cloud functions. It enables 
apps to easily scale, recover from errors, and start 
quickly. The best solution for agility and efficiency.

Kubernetes automates your app management by 
automating the deployment, scaling, and management of 
containerized applications.

Prometheus is a monitoring and alerting tool that helps 
you track and analyse metrics from various systems and 
applications.

Grafana & Kibana are data visualization tools.  
They help you make sense of complex data stored in  
e.g. Elasticsearch or Loki by creating interactive charts 
and graphs.

Jaeger is a distributed tracing system. It helps you 
troubleshoot and optimize complex systems by 
visualizing interactions between instrumented with 
OpenTelemetry.

Fluentd is a data collection and forwarding tool. It helps 
you unify your log data to multiple destinations like 
elasticsearch or loki for analysis and processing.

OpenTelemetry provides unified APIs and libraries 
for distributed tracing, metrics, and logging. Monitor 
performance and behavior across different systems.



CLOUD NATIVE 
BOOTCAMP
Dive into the world of DevOps, Source 
Control Management, CI/CD and 
Containers. 

DESCRIPTION 

We will start this course by introducing Git , the most 
widely used source control management software. Git 
will help you to keep track of your code.

On the second day, GitLab CI, a widely used continuous 
integration software, will be our focus. GitLab CI 
provides mechanisms with which we can automate test 
processes for newly written code, improve code quality 
and manage the delivery of our code.

On day three and four, you will learn everything 
you need to know to get started in the world of 
Docker, Containers and Kubernetes. Kubernetes is 
quickly becoming the de-facto standard to operate 
containerized applications at scale. This course 
covers the essential knowledge needed to understand 
Kubernetes and includes instructions on how to deploy 
distributed applications that will scale, be fault-tolerant 
and simple to manage.

During the last two days, we dive into the world of 
Observability. The ability to observe services, is 
becoming increasingly important in the world of 
DevOps, Containers and Microservices. The more 
Containers/Services you operate, the more difficult it 
becomes to keep track of them. We will show how you 
can always know how your services are doing.

AGENDA 

> Source control with Git
> Git-Workflows
> Solving Git conflicts
> What is CI/CD?
> Building pipelines with GitLabCI
> Monolith vs Micro services
> 12-Factor-App
> API Gateways
> Kubernetes Essentials
> Observability
> Logging, Monitoring, Tracing, Alerting
> Fluentd, Prometheus, Grafana, Jaeger, OpenTelemetry
> Chaos Engineering

AUDIENCE

> �Software Developers that want to have 
control over their source code

> �System-, Cloud-Administrators and 
Developers that want to reduce time spent on 
deployment and testing

> �System- and Cloud-Administrators interested 
in, or responsible for, maintaining a large 
number of servers or virtual instances

> �Software developers that want to learn 
how to deploy their applications within 
Kubernetes

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux terminal

6 Days BeginnerTopic: Cloud Native

„This training was put 
together individually for a 

German telecommunications 
company. We can do that for 

you too!“

 The CustomCat says:

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/cloud-native-bootcamp/


CLOUD NATIVE 
ESSENTIALS
This is an introduction to Kubernetes, 
an open-source system for automating 
deployment, scaling, and management 
of containerized applications.

DESCRIPTION 

This course will teach you everything you need to 
know about container and how to use Kubernetes to 
manage your application infrastructure. Kubernetes 
is quickly becoming the de-facto standard to operate 
containerized applications at scale.

This course covers the essential knowledge needed 
to understand Containers as well as Kubernetes and 
includes instruction on how to deploy distributed 
applications that will scale, be fault-tolerant and simple 
to manage.

AGENDA 

> Microservices vs. Monolith
> Architecture and Theory
> 12-Factor-App
> Docker Images
> Containerizing Applications
> Container Networking
> Volumes and Persistent Data
> Secrets
> Docker Compose
>	Container Orchestrators
>	What is Kubernetes
>	Kubernetes Architecture
>	Working with Pods
>	Kubernetes Services
>	Volumes and Data
>	ConfigMaps and Secrets
>	Ingress

„88% of RedHat customers 
have chosen Kubernetes 

when it comes to container 
orchestration.“* 

     The SmartCat tip

AUDIENCE

> �Software developers that want to understand 
the core concepts to containerize their 
application and how to deploy their 
applications within Kubernetes

> �System Administrators that want to use 
container technologies and support their 
development teams as container experts

> �System Administrators that want to use 
container technologies and support their 
development teams as container experts

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux terminal

2 Days BeginnerTopic: Cloud Native

* https://www.redhat.com/en/resources/kubernetes-adoption-security-market-trends-2021-overview

TAKE A LOOK ONLINE 

https://www.redhat.com/en/resources/kubernetes-adoption-security-market-trends-2021-overview
https://www.infralovers.com/courses/cloud-native-essentials/


OBSERVABILITY
Analyse the current state of 
your services.

DESCRIPTION 

The topic of Observability is becoming increasingly 
important in the world of DevOps, containers and 
micro services. The more containers / services you 
operate, the more difficult it becomes to keep track of 
everything. We will show you how you can always know 
how your services are doing.

This training deals with the four pillars of observability: 
monitoring, logging, tracing and visualization. Tools 
with practical examples are presented for each pillar: 
Fluentd, Kibana, Prometheus, Grafana, Jäger and 
OpenTelemetry.

AGENDA 

>	What is Observability
>	Logging
>	Monitoring / metrics
>	Traces
>	Alerting / visualization
>	Log aggregation and analytics of containers / micro 

services
>	Logging using the EFK stack
>	The F in EFK: Fluentd
>	Visualization with Kibana
>	Monitoring of containers / micro services
>	Monitoring using Prometheus
>	Visualization with Grafana
>	Tracing in distributed systems
>	Tracing using Jäger
> Tracing, Metriken and Logging with OpenTelemetry
>	Chaos Engineering in the observability context

AUDIENCE

Operators that want to have insights into 
their services.

PREREQUISITES

>	Cloud Native Essentials
>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

2 Days IntermediateTopic: Cloud Native

„Anyone who does not have an 
overview of the current state 
of their IT infrastructure will 

soon hit a wall!“

The PerceptiveParrot tip

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/observability/


TRAININGS 

ABOUT INFRASTRUCTURE AS CODE

TOOLS

Building and manag-
ing with code, brings 
consistency, efficien-

cy, and agility.

Infrastructure as code 
provides consistency, 
efficiency, and agility by 
allowing IT infrastructure to 
be managed and provisioned 
through code rather than 
manual processes.

KING
OF CLOUD
TRAININGS

Ansible Essentials	
Ansible AWX	
Chef Essentials	

Terraform Foundations	
HCP Terraform & Enterprise	  
Terraform Plugin Entwicklung	  
Terraform Testing	

With IaC you manage and provisions 
computing infrastructure using machine-
readable definition files instead of manual 
configuration. Deploy and manage easier 
and more reliable infrastructure, promoting 
consistency and scalability.

Ansible this automation tool simplifies your deployment 
and management of your applications and systems. 
It uses a simple syntax and an agentless architecture 
to automate routine IT tasks, such as configuration 
management, application deployment, and 
orchestration.

Chef Infra is an automation tool that helps you manage 
complex infrastructure by automating configuration, 
deployment, and maintenance tasks. 

CINC is an open-source solution and offers the same 
value to end-users as the upstream product. Chef Infra 
cookbooks will work just as well within the Cinc Client.

Terraform enables you to easily create, manage, and 
update infrastructure as code across multiple cloud 
providers and on-premises, reducing human error and 
increasing efficiency.

OUR
IaC
COURSES
INFRASTRUCTURE AS CODE



DESCRIPTION 

Our Ansible 101 training is the perfect starting point 
to get in contact with Ansible because you do not need 
any former knowledge on the topic. You will learn 
how to automate the configuration, deployment, and 
management of your server infrastructure.

This course is only available for Linux on the control 
plane. The concepts learned can also be applied to 
Windows hosts without restriction.

AGENDA 

>	Introduction to Configuration Management
>	Create your first Ansible playbook
>	Work with an Ansible inventory
>	How to use variables, facts, and imports
>	Ansible Templating
>	Ansible Roles and Ansible Galaxy
>	Outlook: Test your playbooks

ANSIBLE 
ESSENTIALS
The perfect base to learn how to use 
configuration management for your 
services.

AUDIENCE

System- and Cloud-Administrators 
interested in, or responsible for, 
maintaining a large number of servers or 
virtual instances

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

1 Day BeginnerTopic: IaC

“There is only one thing 
that is more expensive than 

education in the long run: no 
education.“  

- John F. Kennedy

The FlyingCow quote

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/ansible-101/


DESCRIPTION 

This training builds on the Ansible 101 course and 
deepens your knowledge even more. Topics of this 
training course is Ansible Tower and its provisioning 
so that non-Ansible users can handle configuration 
automation.

This course is only available to Linux clients, but 
Windows and Linux hosts can be managed.

AGENDA 

>	Revisit Ansible roles and inventory
>	Ansible Tower - How does it work?
>	Ansible AWX vs. Ansible Tower
>	Ansible Tower - How to automate
>	Ansible Tower - How to distribute configuration 

automation

ANSIBLE AWX
This training is the follow up to the 
Ansible 101 training and will deepen 
your understanding even more.

AUDIENCE

System- and Cloud-Administrators 
interested in, or responsible for, 
maintaining a large number of servers or 
virtual instances

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux terminal
>	Ansible 101

2 Days AdvancedTopic: IaC

The beautiful thing about 
learning is that no one can 

take it away from you.
- B.B. King

The Unicorn quote

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/ansible-tower-101/


CHEF ESSENTIALS
The perfect base to learn how to use 
configuration management for your 
services.

AUDIENCE

System- and Cloud-Administrators 
interested in, or responsible for, 
maintaining a large number of servers or 
virtual instances

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

2 Days BeginnerTopic: IaC

DESCRIPTION 

Our Chef Essentials training is the perfect starting 
point to get in contact with Chef Infra because you do 
not need any former knowledge on the topic.

Using the open source alternative CINC, you will learn 
how to automate the configuration, deployment, 
and management of your server infrastructure. In 
addition to that, we will teach you how to test your 
configurations so that you are able to automate your 
whole infrastructure.

AGENDA 

>	Introduction
> Chef resources
> Cookbooks
> Chef-Client
> Testing cookbooks
> Details about the system
> Desired state and data
> Using Chef-Workstation
> The Chef server
> Community cookbooks
> Managing multiple nodes
> Roles & Environments
> Search

„Knowing is not enough - you 
have to apply. It is not enough 
to want - you have to do it too.“ 

- Goethe

The WiseWhale quote

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/chef-essentials/


OUR
DEVOPS &
CI/CD
COURSES
CONTINUOUS INTEGRATION &  
CONTINUOUS DEPLOYMENT

TRAININGS 

ABOUT DEVOPS, TESTING, CONTINUOUS INTEGRATION & CONTINUOUS DEPLOYMENT

TOOLS

Automate testing, and 
deployment, bring speed, 

quality, and reliability to your 
process. Like doing everything 
with 8 arms at the same time.

CI/CD enables faster and 
more reliable software 
delivery, better collaboration, 
and faster error detection 
and recovery.

Testing helps ensure 
software applications meet 
your needs, are reliable and 
secure, and can be deployed 
quickly and with confidence.

KING
OF CLOUD
TRAININGS

Agile Testing CI/CD Bootcamp	
GitLab Essentials	
GitOps	
Agile Testing Essentials - Ruby & Cucumber	
Agile Testing Essentials - Python & Behave	
AI/LLM Essentials for DevOps	
Terraform Testing	

Emphasize automated building, testing and 
deployment. Different tools help you catch 
bugs early, deliver software faster and more 
reliably and test your CI/CD.

Git is used in CI/CD to manage source code changes and 
automate software delivery. It helps to ensure that changes 
are tested, built, and deployed quickly and reliably, 
improving software quality and reducing delivery time. 

Cucumber automates testing of software features and 
ensures they meet user requirements. It improves 
collaborations between developers and non-technical 
stakeholders.

Programming Language Basics of Go, Ruby and Python 
will be needed in some of our courses. We’ll teach you 
just enough basics to master our trainings.

Terraform enables you to easily create, manage, and 
update infrastructure as code across multiple cloud 
providers and on-premises, reducing human error and 
increasing efficiency. Therefore Terraform Testing is 
crucial to keep things running smoothly. 



AGILE TESTING
CI/CD BOOTCAMP
Run your tests on autopilot with 
CI/CD pipelines.

DESCRIPTION 

We will start this course by introducing Git , the most 
widely used source control management software. Git 
will help you to keep track of your code.

GitLab CI, a widely used continuous integration 
software, will be our focus. GitLab CI provides 
mechanisms with which we can automate test 
processes for newly written code, improve code quality 
and manage the delivery of our code.

Our “Agile Testing” part teaches you how to efficently 
test your applications and systems with ease. 
Nevertheless, most of these test will still get triggered 
manually by an employee. Combining agile tests with 
a CI/CD pipeline can make them run automatically 
whenever a change occrus.

This course will show how combining agile tests 
with a CI/CD pipeline can avoid errors and failure by 
automating the running of these tests.

AGENDA 
> Source Control with Git
> Git-Workflows
> Solving Git conflicts
> What is CI/CD?
> Building pipelines with GitLabCI
>	Introduction to Python OR Ruby
>	Python OR Ruby Datatypes and Control Structure
>	Understand Software Testing
>	Development Driven Testing
>	Test Driven Development & Behavior Driven Develop-

ment
>	Introduction to Behave OR Cucumber
>	Develop and Test a REST API with the BDD methodology
>	How to introduce agile testing methods in your company
>	Review agile testing & CI/CD pipelines
>	Combining both to truly automate tests
>	Pitfalls to avoid and best-practices

AUDIENCE

> �System Integrators that want to use 
BDD and Cucumber to test already 
existing applications and systems

> �Software Developers that want to use 
BDD to avoid bugs and make code 
changes possible without breaking 
existing functionality

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

5 DaysTopic: Testing/CI/CD

„Education is the passport 
to the future, for tomorrow 

belongs to those who prepare 
for it today.“ 
- Malcolm X

The FixingFlamingo quote

Beginner

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/agile-testing-ci-cd-bootcamp/


GITLAB
ESSENTIALS
Collaborate and ship your code 
faster with Git and GitLab.

DESCRIPTION 
This course introduces Git with an additional focus on 
using GitLab. You will learn to track changes with the 
most popular Source Control Management software git: 
No more losing code!

We will teach you how to collaborate on a shared code 
base, how to manage releases and how to establish a 
workflow that will help you ship code faster with Git and 
GitLab.

With a duration of two days, we can commit more time 
to practical examples in this course and allow more 
room for custom Git/GitLab workflows.

AGENDA 
>	Why use a Version Control System?
>	Introduction to Git
>	What is a repository?
>	Modifying, staging and committing changes
>	Working with Branches
>	Remote repositories
>	Using your own GitLab server
>	Working together on a repository
>	Merge Requests and pulling changes
>	Resolving conflicts
> Complex Git workflows
> Introduction to DevOps CI/CD
> GitLab-CI outline 
> What are pipeline jobs?
> GitLab-Runner-Setup (optional)
> Building the first Build Pipeline with GitLab-CI
> Writing jobs as Code (gitlab-ci.yml)
>	CI/CD Hands-On

AUDIENCE

> �Software Developers that want to have 
control over their source code

> �Integration Engineers that need to 
combine several code pieces into one 
releasable code base

> �Operation Engineers that need an easy 
way to access releases

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

2 DaysTopic: SCM

“All knowledge consists in 
certain and clear realisation.“  

- René Descartes

The CleverRacoon quote

Beginner

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/gitlab-essentials/


GITOPS
Continuous Delivery meets Cloud 
Native.

DESCRIPTION 

GitOps is a new method to manage Kubernetes clusters 
and application deployments. This is achieved by plac-
ing configuration-as-code into a Git repository as the 
single source of truth. Everything else is then automati-
cally handled by connected CI/CD systems.

This course will take you through all the important 
parts of GitOps and help you to choose best tools for 
setting up your GitOps workflow.

AGENDA 

>	Introduction to GitOps
>	A single point of change
>	Collaborative GitOps workflow
>	Integrate with popular CI tools
>	Deploy to Kubernetes via GitOps
>	Security and GitOps

AUDIENCE

Anyone that wants to deploy to K8s 
efficiently.

PREREQUISITES

>	Cloud Native Essentials
>	GitLab Essentials

KING
OF CODE
TRAININGS

2 DaysTopic: SCM

„Nothing works in IT these 
days without Git. If you want to 

get to the next level with this 
course, you should visit our 

Git course beforehand.„

The GitCat says:

Beginner

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/gitops/


AGILE TESTING
ESSENTIALS

Hands-on exercises will give you the 
expertise you need to automate your 
tests with cucumber and ruby.

DESCRIPTION 

The classic approach is to write code and then write a 
test for it. This often leads to tests being neglected.

Behavior Driven Development (BDD) tries to solve this 
problem and helps you to avoid bugs. Tests are being 
written as actual user-stories rather than just code with 
BDD. This leads to valuable, well-defined specifications 
of the system’s intended behaviour.

Learn to take advantage of BDD by using tools like 
Cucumber.

AGENDA 

>	 Introduction to Ruby
>	 Ruby Data types and Control Structure
>	 Understand Software Testing
>	 Development Driven Testing
>	 Test Driven Development
>	 Behavior Driven Development
>	 Introduction to Cucumber
>	 Develop and Test a REST API with the BDD methodology
>	 How to introduce agile testing methods in your compa-

ny

AUDIENCE

> �System- and Cloud-Administrators 
interested using automated testing 
tools like Cucumber.

> �Developers that want to manage 
resources for development and testing 
environments

> �System-, Cloud-Administrators and 
Developers that want to reduce time 
spent on deployment and testing

> �System-, Cloud-Administrators and 
Developers that want to increase test 
coverage

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

3 DaysTopic: Testing

„The best way to predict your 
future is to create it.“ 

- Abraham Lincoln

The TestOpus quote

Beginner

RUBY & CUCUMBER

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/agile-testing-essentials-rc/


AGILE TESTING
ESSENTIALS

Hands-on exercises will give you the 
expertise you need to automate your 
tests with python and behave.

DESCRIPTION 

The classic approach is to write code and then write a 
test for it. This often leads to tests being neglected.

Behavior Driven Development (BDD) tries to solve this 
problem and helps you to avoid bugs. Tests are being 
written as actual user-stories rather than just code with 
BDD. This leads to valuable, well-defined specifications 
of the system’s intended behaviour.

AGENDA 

>	Introduction to Python
>	Python Datatypes and Control Structure
>	Understand Software Testing
>	Development Driven Testing
>	Test Driven Development
>	Behavior Driven Development
>	Introduction to Behave
>	Develop and Test a REST API with the BDD methodology
>	How to introduce agile testing methods in your company

AUDIENCE

> �System- and Cloud-Administrators 
interested using Behave

> �Developers that want to manage 
resources for development and testing 
environments

> �System-, Cloud-Administrators and 
Developers that want to reduce time 
spent on deployment and testing

> �System-, Cloud-Administrators and 
Developers that want to increase test 
coverage

PREREQUISITES

>	Basic understanding of Linux
>	Basic experience with the Linux 

terminal

3 DaysTopic: Testing

„The best way to predict your 
future is to create it.“ 

- Abraham Lincoln

The TestOpus quote

Beginner

PYTHON & BEHAVE

BEHAVE
TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/agile-testing-essentials-pb/


AI/LLM 
ESSENTIALS

Learn AI/LLM basics in one day for De-
vOps, Cloud-Native, and IT-Security to 
enhance workflows and security.

DESCRIPTION 

In this entry-level course, participants will gain a 
foundational understanding of artificial intelligence 
(AI) and large language models (LLMs). This one-day 
workshop is tailored specifically for professionals in 
DevOps, Cloud-Native, and IT-Security. This course will 
demystify AI/LLM concepts and showcase practical 
applications within these domains.

Students will learn how AI and LLMs can streamline 
workflows, enhance security protocols, and drive 
innovation in their organizations. Through a 
combination of theoretical knowledge and presenter 
demonstrations, participants will explore the 
integration of AI/LLM technologies into existing 
infrastructures, focusing on real-world use cases such 
as automated monitoring, threat detection, incident 
response, and predictive maintenance. By the end of 
the day, attendees will be equipped with the skills and 
insights needed to leverage AI/LLM to optimize their 
daily workloads.

AGENDA 

>	Basics of AI and machine learning
>	Introduction to large language models
>	How to run your own AI/LLM (Ollama)
>	Using the LangChain Framework
>	Integration into existing systems
>	Demonstrating DevSecOps use cases

AUDIENCE

> �Everyone who is interested in AI/LLM.

PREREQUISITES

>	Stable internet connection
>	Modern browser

1 DayTopic: DevOps

“AI and LLMs enhance DevOps 
by automating repetitive tasks, 

optimizing workflows, and 
providing real-time insights, 

enabling teams to work 
more efficiently and focus on 

innovation.”

The AIntelope quote

Beginner

FOR DEVOPS

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/ai-llm-foundations-for-devops/


OUR
IT-SECURITY
& MONDOO
COURSES

TRAININGS 

ABOUT SECURITY, SECURITY STANDARDS AND REDUCING RISKS

TOOLS

Mondoo automates 
compliance and 
security checks, 

streamlining vulner-
ability detection and 

management with 
real-time insights 

and custom policies.

Mondoo automates security 
audits and compliance 
checks, ensuring your 
systems meet standards like 
NIS2 and ISO 27001 while 
detecting vulnerabilities 
efficiently. Its real-time 
insights and custom 
policy creation streamline 
security management and 
remediation processes.

KING
OF CLOUD
TRAININGS

Mondoo Essentials
Mondoo Advanced
EU NIS2 Guidelines

Using Mondoo is crucial for maintaining robust 
security and compliance, as it automates 
audits, detects vulnerabilities, and ensures 
adherence to standards like NIS2 and ISO 
27001.

Automated Security Audits. Mondoo automates 
the process of auditing security configurations and 
compliance, saving time and reducing human error.

Vulnerability Detection. It identifies and highlights 
security vulnerabilities across your infrastructure, 
helping to proactively address potential threats.

Compliance Assurances. Mondoo ensures adherence to 
industry standards and regulations, such as NIS2 and 
ISO 27001, by continuously checking and reporting on 
compliance status.

Custom Policy Creation. Users can create and manage 
custom security policies tailored to their specific needs 
and requirements.

Real-Time Insights. Provides actionable insights and 
detailed reports to keep you informed about your 
security posture and compliance status.

Integration with Systems. Mondoo integrates seamlessly 
with various systems and platforms, including cloud 
services, containers, and other infrastructure components.



MONDOO
ESSENTIALS
Gain hands-on experience with Mondoo, 
mastering its features, custom policies, 
and advanced security management.

DESCRIPTION 

This course offers a comprehensive introduction 
to Mondoo, a leading security tool that enhances IT 
security. Participants will gain hands-on experience in 
configuring and using Mondoo to detect vulnerabilities, 
ensure compliance with standards like NIS2 and ISO 
27001, and manage security risks across various 
environments.

Covering Mondoo’s architecture, core features, 
integration with systems like cloud services and 
containers, vulnerability scanning, compliance checks, 
and security monitoring. Advanced topics include 
creating custom policies, automating security tasks, 
generating detailed reports, and incident response 
techniques. Interactive labs will equip participants with 
the skills needed for effective security management 
using Mondoo.

AGENDA 

>	Introduction to Mondoo
>	Setup and configuration
>	Integrating Mondoo with various systems (AWS/Azure, 

Kubernetes, VMs, Containers etc.)
>	Vulnerability scanning with cnquery
>	Compliance checks with MQL
>	Custom policy creation with cnspec
>	Automate security tasks and monitoring
>	Reporting and analytics
>	Incident response and remediation

AUDIENCE

> �IT security professionals responsible 
for securing infrastructure and 
managing security tools

> �Compliance officers responsible for 
ensuring organizational compliance 
with industry standards and 
regulations (e.g. NIS2, ISO 27001)

> �Auditors conducting security audits 
who need to understand the current 
state of security in an organization

> �DevOps engineers focused on 
combining software development and 
IT operations

PREREQUISITES

>	Stable internet connection
>	Modern browser

2 DaysTopic: Security

“Like a vigilant guard dog, Mondoo 
doesn’t just bark—it protects, 

ensuring your security stays strong 
and unbreakable.”

The Guard-Dog says

Beginner

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/mondoo-foundations/


MONDOO
ADVANCED
Gain hands-on experience with Mondoo, 
mastering its features, custom policies, 
and advanced security management.

DESCRIPTION 

This advanced one-day training course is designed for 
participants who have already completed the initial 
two-day Mondoo Foundations training. The course 
will delve into more sophisticated aspects of Mondoo, 
focusing on policy scoring, exception handling, 
data exporting, smart ticketing, custom compliance 
frameworks and deeper dive into ensuring compliance 
with standards like NIS2 and ISO 27001

By the end of the training, participants will have a 
deeper understanding of these advanced features 
and how to leverage them for enhanced security 
management in their organizations.

AGENDA 

>	Recap of key Mondoo concepts
>	Customizing the scoring system
>	Managing check exceptions and advisory exceptions
>	Set up smart ticketing for efficient issue management
>	Export data to aggregation and GRC tools
>	Implement a custom compliance framework in Mondoo

AUDIENCE

> �IT security professionals responsible 
for securing infrastructure and 
managing security tools

> �Compliance officers responsible for 
ensuring organizational compliance 
with industry standards and 
regulations (e.g. NIS2, ISO 27001)

> �Auditors conducting security audits 
who need to understand the current 
state of security in an organization

> �DevOps engineers focused on 
combining software development and 
IT operations

PREREQUISITES

>	Mondoo Foundations

1 DayTopic: Security

“Mondoo automates security 
audits, detects vulnerabilities, 
and delivers insights, ensuring 

seamless compliance and 
system security.”

The Guard-Dog says

Intermediate

TAKE A LOOK ONLINE 

https://www.infralovers.com/courses/mondoo-foundations/


EU NIS2
GUIDELINES
Gain in-depth knowledge of the EU NIS2 
guidelines in this one-day workshop, 
covering key provisions, compliance 
requirements, and best practices for or-
ganizational implementation.

DESCRIPTION 

This comprehensive one-day workshop is designed to 
provide an in-depth understanding of the EU Network 
and Information Security Directive 2 (NIS2) guidelines, 
a critical regulatory framework aimed at enhancing 
cybersecurity across the European Union. Participants 
will gain valuable insights into the key aspects of NIS2, 
its implications for various sectors, and strategies for 
compliance.

Ideal for IT professionals, compliance officers, and 
organizational leaders, this workshop will equip 
participants with the knowledge needed to navigate and 
comply with NIS2 requirements effectively.

AGENDA 

>	Introduction to NIS2
>	Evolution from NIS1 to NIS2
>	Key objectives and scope of NIS2
>	Differences between NIS2 and DORA
>	Overview of critical sectors and services under NIS2
>	Security and notification requirements
>	Governance and risk management practices
>	Responsibilities of operators of essential services 

(OES) and digital service providers (DSP)
>	Compliance strategies and best practices

AUDIENCE

> Organization leaders that want to 
make their organization NIS2 compliant
> IT security professionals responsible 
for securing infrastructure and managing 
security tools
> Compliance officers responsible for 
ensuring organizational compliance with 
industry standards and regulations

PREREQUISITES

>	Stable internet connection
>	Modern browser

1 DayTopic: Security

“I am checking everything, 
if it’s not correckt… chock-a-

doodle-doo!”

The Picky Rooster says

TAKE A LOOK ONLINE 

Beginner

https://www.infralovers.com/courses/eu-nis2-guidelines/


THE
TRAINING

THAT FITS 
YOUR NEEDS

BUI

LDWhat seems like a strange 
combination might just be 
right for you.  
Let us know your wishes 
and we will create your 
perfect training.

KING OF
INDIVIDUAL
TRAININGS

A LITTLE BIT OF THIS
What we mean by that: There is no such thing as 
impossible, only incredibly tailor-made training 
courses that are precisely customised to your business 
requirements. We don’t do “off the shelf”.

THE PERFECT MIX
The key to personal training success 
is a balanced mix of encouragement 
and challenges - the motivating 
motto: really learn instead of just 
taking part.

AND A LITTLE BIT OF THAT
We cook every course fresh - without artificial 

flavours or produce. Our trainers recognize the 
recipes with which every course participant gets 

out of the comfort zone - and jumps into the 
superhero zone.



Custom trainings for high 
performance teams.

YOUR TEAM 
IS CAPABLE 
OF MORE

Infralovers GmbH
 
Janneckweg 3/3
8042 Graz
Österreich

team@infralovers.com
+43 676 3282554

www.infralovers.com

Non-binding course offer, subject to adjustments.
Errors and omissions excepted.
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